
 
 

 

 

 

 

 

 

 

 

ÕPILASTE Kirjalike tööde  

vormistamise juhend 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pärnu 2023 

  



2 

 

 
Sisukord 

 

Üldnõuded ................................................................................................................................................3 

Tiitelleht ....................................................................................................................................................3 

Sisukord ....................................................................................................................................................4 

Pealkirjad ..................................................................................................................................................4 

Tabelite, jooniste, valemite, loetelude ja lisade vormistamine ...................................................................5 

 Tabelid ..............................................................................................................................................5 

 Joonised ............................................................................................................................................6 

 Valemid .............................................................................................................................................6 

 Loetelud ............................................................................................................................................7 

 Lühendid ...........................................................................................................................................7 

Viitamine ja kasutatud kirjandus ................................................................................................................8 

Lisade vormistamine .................................................................................................................................9 

Lisad ....................................................................................................................................................... 10 

 Lisa 1. Tiitellehe näidis .................................................................................................................... 10 

 Lisa 2. Sisukorra näidis ................................................................................................................... 11 

  



3 

 

Üldnõuded 

• Kirjalikud tööd vormistatakse arvutil ning esitatakse valge kirjutuspaberi ühel poolel. 

• Paber (Page Layout→Size) suurusega A4 (21 × 29,7 cm). 

• Veerised (Page Layout→Margins→Custom Margins) üleval, all ja paremal 2,5 cm ning vasakul 

3,5 cm. 

• Kiri (Home→Font): Times New Roman suurusega 12 pt. 

• Reavahe (Home→Paragraph→Line Spacing): 1,5 rida. 

• Lõiguvahed (Home→Paragraph→Spacing): tekstilõikude vahed on enne (before) 0 punkti ja 

pärast (after) 12 punkti, v.a sisukorras ja loeteludes, kus lõiguvahed on enne ja pärast 0 punkti 

ning esimese pealkirjatüübi (Heading 1) puhul enne (before) 24 punkti ja pärast (after) 12 punkti. 

• Teksti joondus (Home→Paragraph→Alignment): rööpselt (Justify / Justified). 

• Leheküljenumbrid (Insert→Page Number): lehed nummerdatakse automaatselt, kusjuures 

tiitelleht on esimene leht, millele aga numbrit ei panda. Ülejäänud lehtedel asuvad need lehekülje 

all paremas nurgas. Lisadel ei kuvata leheküljenumbeid. 

Töö osade järjestus on järgmine: 

1. tiitelleht; 

2. sisukord; 

3. sissejuhatus; 

4. sisu peatükkidena; 

5. kokkuvõte; 

6. kasutatud kirjandus; 

7. lisad. 

• Töö peatükke või teisi iseseisvaid osi (sisukord, sissejuhatus, kokkuvõte, kasutatud kirjandus, 

lisa(d) jne) alustatakse uuelt leheküljelt.  

• Alapunkte alustatakse samalt leheküljelt. Jälgida, et lisaks pealkirjale mahuks leheküljele ka 

järgnevat teksti (vähemalt 2 rida). 

• Lehekülje vahetuseks ei tohi kasutada klahvi Enter, vaid sundleheküljevahetust 

(tekstitöötlusprogrammis klahvikombinatsioon Ctrl+Enter või Page Layout→Breaks→Page). 

 

Tiitelleht 

Tiitellehel on järgmised elemendid: 

• õppeasutus; 

• õppekava nimetus; 

• autori ees- ja perenimi; 

• töö pealkiri; 

• juhendaja ees- ja perenimi; 

• töö valmimise koht (Pärnu) ja aasta. 

 

Kirjasuurus tiitlellehel 14 punkti, v.a pealkiri, mis on rasvase 18-punktise kirjaga. 

Lõiguvahed on näha järgmises näites. Praktikaaruande tiitellehe näidis lisas 1. 
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Näited 

 
PÄRNU SAKSA TEHNOLOOGIAKOOL 

Õppekava nimetus 

 
 
 
 
 

Õpilase ees- ja perenimi 

PRAKTIKAARUANNE 

 
 
 

Juhendaja: 
Ees- ja perenimi 

 

 
 

Pärnu 2023 
 

 
Lõiguvahe enne 0 pt  

ja pärast 0 pt 

 

 

 

 

Enne 180 pt; pärast 12 pt 

 

Enne 0 pt; pärast 0 pt 

 

 

Enne 90 pt; pärast 0 pt 

 

Enne 0 pt; pärast 0 pt 

 

 

 

Enne 210 pt; pärast 0 pt 

 
PÄRNU SAKSA TEHNOLOOGIAKOOL  

Õppekava nimetus 

 
 
 
 
 

Õpilase ees- ja perenimi  

PEALKIRI 
Lõputöö / Uurimustöö 

 
 

Juhendaja: 
Ees- ja perenimi 

 

 
 

Pärnu 2023 
 

 
Lõiguvahe enne 0 pt  

ja pärast 0 pt 
 
 
 
 
 
 

Enne 150 pt; pärast 12 pt 
 

Lõiguvahe enne 0 pt  
ja pärast 0 pt 

 
Enne 66-90 pt*;  

pärast 0 pt 

Enne 0 pt; pärast 0 pt 

 
 
 

Enne 210 pt; pärast 0 pt 

 

* Kaherealise pealkirja puhul soovituslik lõiguvahe enne 90pt, 

   kolmerealise puhul 66 pt. 

 

 

Sisukord 

Sisukord paigutatakse töö algusesse tiitellehe järele. Sisukorras näidatakse kõik töö alljaotused täpses 

vastavuses töös olevate pealkirjade ja leheküljenumbritega, millest vastav alljaotus algab. Sisukorra 

koostamisel kasutatakse tekstitöötlusprogrammi automaatset sisukorra loomise valikut 

(References→Table of Contents→Insert Table of Contents). 

 

Näide lisas 2. 

 

 

Pealkirjad 

• Pealkirja sõnastus peab olema võimalikult lühike, kuid hõlmama jaotise sisu. 

• Pealkirjade lõppu punkti ei panda ning sõnu ei poolitata. 

• Kui pealkirjas on kaks lauset, siis pannakse lausete vahele punkt, rea lõppu aga mitte. 

• Kõik pealkirjad algavad lehe vasakust äärest (vasakjoondus). 

• Sisulise osa peatükid ja nende allosad tähistatakse järjekorranumbritega (kümnendsüsteemis 

araabia numbrid, näiteks 1.; 2.3;  3.1.1 jne). Sissejuhatus, kokkuvõte, kasutatud kirjandus ja lisad 

on ilma järjekorranumbriteta, kuid loetletakse sisukorras. 

• Kuna tekstitöötlusprogrammides võivad olla erinevad pealkirjade stiilid, siis tuleb need ise 

kohandada, lähtudes järgmistest nõuetest: 

1. esimene pealkirjatüüp (Heading 1) – Times New Roman, kirja suurus 16 punkti, rasvases püstkirjas, 

lõiguvahe enne (before) 24 punkti ning pärast (after) 12 punkti; 

1.1. teine pealkirjatüüp (Heading 2) – Times New Roman, kirja suurus 14 punkti, rasvases püstkirjas; 

1.1.1. kolmas pealkirjatüüp (Heading 3) - Times New Roman, kirja suurus 12 punkti, rasvases 

püstkirjas. 
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Tabelite, jooniste, valemite, loetelude ja lisade vormistamine 

 

Tabelid 

• Tabeleid kasutatakse üldjuhul arvulise materjali kompaktseks ja süstematiseeritud esitamiseks. 

Tabelitel on pealkirjad, mis sisestatakse lehe vasakusse serva (vt tabel 1) kirjasuurusega 11 

punkti. Tabelites kasutatav reavahe on 1,0 (Single) ning kirjasuutus 11 punkti. Tabelid 

nummerdatakse kas kogu töö lõikes (Tabel 5) või iga peatüki ulatuses eraldi (Tabel 2.3). Tabel 

paigutatakse selle tekstilõigu järele, milles talle viidatakse. Võib kasutada kas otsest viitamist 

(näiteks: Alljärgnev tabel 1 iseloomustab....) või kaudset viitamist (vaata tabel 5) või (vt tabel 5).  

Peale sellist viidet peaks kas kohe või töö järgmisel leheküljel järgnema tabel. 

• Kui tabel on suurem kui üks A4 lehekülg, siis tuleb see esitada lisana. 

• Kui tabelis kasutatakse kirjandusest/allikatest võetud andmeid, siis peab tabeli pealkirja järel 

olema viidatud allikale. 

 

Tabel 1. Kutsehariduse omandamine viimastel aastatel koolitusala järgi1 

  Vastuvõetud Õppijad Lõpetanud 

2013 2014 2013 2014 2013 2014 

Koolitusalad kokku 11 325 11 516 25 699 25 237 7 861 7 638 

Kunstid 549 611 1 442 1 386 282 371 

Ärindus ja haldus 1 368 1 528 2 503 2 600 946 830 

Arvutiteadused 932 1 002 2 314 2 494 454 507 

Tehnikaalad 2 167 2 139 5 535 5 235 1 624 1 361 

Tootmine ja töötlemine 1 089 1 211 2 294 2 307 803 807 

Arhitektuur ja ehitus 1 049 1 032 2 398 2 327 643 654 

Põllumajandus, metsandus ja kalandus 779 772 1 772 1 724 552 588 

Tervis 67 0 272 1 73 0 

Sotsiaalteenused 239 305 467 667 257 302 

Isikuteenindus 1 899 1 619 4 612 4 287 1 468 1 259 

Transporditeenused 825 804 1 608 1 549 524 647 

Keskkonnakaitse 55 38 100 87 28 29 

Turvamine 286 299 336 351 207 264 

 

• Kui kopeeritakse teises programmis (näiteks Microsoft Excel) valmistatud tabeleid, siis tuleb oma 

töösse kleepimisel vaadata üle kirja- ja lõiguvorming (sh šrift, suurus, reavahe jne). 

• Kõigil tabeli veergudel peavad olema sisu iseloomustavad pealkirjad. Järjekorranumbri veergu 

pole soovitatav kasutada. Üldreeglina veerge ei nummerdata. 

• Kui tabel jääb leheküljevahetusele, siis peab uuel lehel olema samuti kuvatud tabeli päiserida. 

Tabeli jätkamisel järgmisel leheküljel kirjutada esimesele tabeliga leheküljele alumisse 

paremasse serva „Tabel 3 jätkub“ – ning järgmisele sama tabeliga lehele kirjutada tabeli ette 

lehekülje paremasse nurka „Tabel 1 järg“. 

 

 
1 Allikas: http://www.stat.ee/58089  

http://www.stat.ee/58089
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Joonised 

• Töös esinevad illustratsioonid (graafikud, diagrammid, skeemid, fotod jne) esitatakse joonistena. 

Joonistel on allkiri (vaata allpool toodud näidet) kirjasuurusega 11 punkti. Joonised 

nummerdatakse kas kogu töö lõikes (Joonis 3) või iga peatüki ulatuses eraldi (Joonis 2.1). 

Kõikidele kasutatavatele joonistele tuleb tekstis viidata (vaata joonis 3) ning need peavad asuma 

võimalikult lähedal kohale, kus neile esmakordselt viidatakse. 

 
Joonis 1. Lõpetajate sooline jagunemine 2015. a 

 

• Joonisel kujutatu tuleb selgitada kas tekstis või joonise piirkonnas. Koordinaattelgi kasutades 

tuleb nendele kanda teljel kujutatavad suurused ja mõõtskaala. 

 

NB! Tabelitel on pealkirjad, aga joonistel allkirjad. 

 

Valemid 

• Valemite vormistamiseks kasutatakse valemiredaktorit (näiteks Microsoft Equation 3.0). 

• Valemid esitatakse omaette real paigutatuna rea keskele. Valemid nummerdatakse nii, et valemi 

number paigutatakse valemirea lõppu ümarsulgudesse. Valemis kasutatavate tähiste seletused 

paigutatakse valemite järele, kusjuures igas uues valemis seletatakse ainult esmakordselt 

esinevaid tähiseid. Sümbolite seletus algab valemirealt peale koma sõnaga „kus“ järgneva 

koolonita. Tähistuste selgitused kirjutatakse vasakjoondusega ülevalt alla erinevatesse ridadesse 

(vaata allolevat näidet). Valemitele osutatakse tekstis enne valemi esitamist. Kirjandusest võetud 

valemite selgitus piirdub viitega allikale.  

Näide  

Moodi arvutamise valem intervallitud variatsioonireas avaldub kujul: 

)()(

)(

11

1

+−

−

−+−

−
+=

MoMoMoMo

MoMo
Mo

ffff

ffk
xMo , kus    (1) 

Mox  – moodiintervalli alampiir, 

k  – moodiintervalli pikkus 

Mof  – moodiintervalli sagedus 

1−Mof  – moodiintervallile eelneva intervalli sagedus 

1+Mof  – moodiintervallile järgneva intervalli sagedus 
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Loetelud 

• Loetelupunktid tähistatakse tavaliselt araabia numbritega, väiketähtedega või mõne sümboliga 

(näiteks punkt, tärn, mõttekriips vms).  

• Loetelu alustatakse väikese tähega ja loetelu osad eraldatakse semikooloniga. 

• Kui loetelupunktide järjekord on oluline, siis kasutatakse numberloendit, muul juhul täpploendit.  

• Kui loetelu on vaja viidata, siis kirjutatakse viide loetelu ette, kuna muul juhul oleks viitega 

tähistatud vaid üks loetelu osa. 

Näide 

Soodustuse taotlemiseks tuleb esitada järgmised dokumendid2: 

a) taotlus soodustuse saamiseks; 

b) õppeasutuse lõpetamist tõendav dokument; 

c) õppeasutuse tõend nominaalse õppeaja kohta, kui kool on lõpetatud enne 2001. aastat; 

d) lapse sünnitunnistus;  

e) taotleja isikut tõendav dokument.  

 

Loetelude vormistamisest lähemalt veebiaadressil: http://keeleabi.eki.ee/artiklid3/loetelu.html. 

 

Lühendid 

• Lühenditest on kirjalikes töödes soovitav kasutada ainult mõõtühikute lühendeid SI-süsteemis 

ehk rahvusvahelises mõõtühikute süsteemis ning üldlevinud sõnade lühendeid (näiteks nr, vt, lk 

jne). Lühendite lõppu punkti ei panda. Enimkasutatavate lühendite õigekirja vaata 

veebiaadressilt: http://www.eki.ee/books/ekk09/index.php?p=2&p1=9&id=67. 

• Nimede lühendite kasutamisel tuleks esmakordsel nime kasutamisel kirjutada välja täispikk nimi 

ning lisada edaspidi kasutatav lühend selle järele sulgudesse, näiteks: Pärnu Saksa 

Tehnoloogiakool (PSTK). Pealkirjades lühendeid ei kasutata. 

• Ühekohalised arvud (0-9) kirjutatakse tekstis sõnadega. Suuremad arvud ja murrud kirjutatakse 

numbritega. Kui aga ühekohalisele arvule järgneb mõõtühik või tähis, siis kirjutatakse ta 

numbriga. Mõõtühiku arvuline väärtus ja ühik tuleb eraldada püsitühikuga (inglise keeles non-

breaking space), mille saab klahvikombinatsiooniga Ctrl+Shift+tühik. Eranditeks on protsendi- ja 

kraadimärk (näiteks 85%; 8°). Rahaliste näitajate puhul esitatakse arvudes kaks kohta peale 

koma, protsendiliste näitajate puhul enamasti üks koht pärast koma. Aastaarvud tuleks alati 

esitada arvuliselt, mitte “käesoleval aastal”, “möödunud aastal” jne.  

 

  

 
2 Allikas: http://keeleabi.eki.ee/artiklid3/loetelu.html  

http://keeleabi.eki.ee/artiklid3/loetelu.html
http://www.eki.ee/books/ekk09/index.php?p=2&p1=9&id=67
http://keeleabi.eki.ee/artiklid3/loetelu.html
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Viitamine ja kasutatud kirjandus 

Oma töö koostamisel kasutatud teiste autorite tööd, põhimõttelised seisukohad, kirjandusallikatest ja 

mujalt pärinevad tsitaadid, valemid, arvulised andmed ja muu tuleb viidata tsitaatide või refereeringutena. 

Kasutatud kirjandusele viitamisel tuleb tekstis märkida sulgudesse: autori perekonnanimi, ilmumise aasta: 

leheküljenumber.  

Näited: (Leppik, 2006: 15) või (Leppik, 2006: 15-18). 

Internetiallikatele viitamisel on sulgudes asutuse nimetus ning külastusaeg, mis on komaga eraldatud. 

Näiteks: (EKI, 19.11.2015) või (Statistikaamet, 17.11.2015). 

Kui viidet ei ole võimalik nii kirja panna, siis on soovituslik kasutada allmärkusi - viiteks sümbol või araabia 

number ning jalusesse tekst: „Allikas: veebiaadress“ (vaata loetelude näidet).  

 

Tsitaat on sõnasõnaline väljavõte kirjandusallikast, mis peab vastama täielikult originaalile ning tuleb 

esitada jutumärkides. Viide lisatakse kohe peale jutumärke, mis lõpetavad tsitaadi.  

Näide 

„On päris selge, et erinevates intellektuaalset tegevust nõudvates tundides saab (võib) kategooria 

iseloomustamiseks kasutada erisuguse varjundiga verbe, mis aga ei muuda eesmärgi põhiolemust.“ 

(Leppik, 2009: 27) 

Tsitaadist väljajäetav osa asendatakse kaldkriipsude vahel oleva punktiiriga (/.../“) 

Näide 

 „/.../ inimese hea enesetunde loob tema psühholoogilise, anatoomilise ja füsioloogilise talitluse soodne 

koostöö, mille tulemuseks on kõrge tööviljakus.“ (Leppik, 2009: 39) 

Refereerimine on teise autori seisukoha ümberjutustamine vabas vormis. Refereeringu puhul jutumärke 

ei kasutata, vajalik on aga viitamine algallikale või autorile. Kui refereering koosneb ühest lausest, siis 

paikneb viide enne lauset lõpetavat punkti, kui aga tervest lõigust, siis pärast punkti. 

Näide 

Leppiku sõnul on see õpetaja omamoodi meister, kes oskab tundides õpitava siduda emotsionaalse 

mängulise tegevusega (Leppik, 2009). 

NB! Viidata tuleb ka kõikidele algallikatest võetud tabelitele, fotodele ja joonistele.  

 

Kasutatud kirjanduse loetelu hõlmab ainult töö koostamisel kasutatud ja viidatud allikaid. 

Allikmaterjal paigutada loetelus järjekorda, kus esimeses järjekorras on raamatud (autori järgi 

tähestikulises järjekorras), ajakirjad, ajalehed ja viimases järjekorras internetist saadud materjalid.  

 

Raamatute puhul kantakse kasutatud kirjanduse loetellu järgmised andmed: 

Autor(id) (perekonnanimi koos initsiaalidega). Pealkiri. Ilmumiskoht: kirjastus (väljaandja), ilmumisaasta 

Näited 

Lindgren, H.C, Suter W.N. Pedagoogiline psühholoogia koolipraktikas. Tartu: Tartu Ülikool, 1994. 

Linnart, K., Kitvel, T. Psühholoogia ja tootmine. Tallinn, 1973. 

Leppik, P. Õppimine on tõesti huvitav. Tartu: Tartu Ülikool, 2006. 

 

Ajakirjade ja ajalehtede puhul näidata: Autor (perekonnanimi koos initsiaalidega). Pealkiri. // Ajakirja või 

ajalehe nimetus. Ilmumisaasta, number (või kuupäev) ja lehekülje number.  
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Näide 

Viigimäe, V. Infosüsteem ei piirdu arvuti ega rakendusprogrammiga. // Ärielu. 1997, nr 11. 

 

Internetist saadud materjalide puhul tuleb ära tuua: 

Autor (kui see on ära toodud). Pealkiri, materjali täielik veebiaadress, materjali kasutamise kuupäev. 

Näited 

Eesti õigekeelsussõnaraamat 2013, http://www.eki.ee/dict/qs/, 18.11.2015. 

Erelt, M., Erelt, T., Ross, K. Eesti keele käsiraamat, 

http://www.eki.ee/books/ekk09/index.php?p=2&p1=11, 18.11.2015. 

 

NB! Veebiaadress vormindada nii nagu ülejäänud andmed.  

 

Asutuse dokumentide puhul näidata:  

Dokumendi nimetus. Asutuse nimetus, dokumendi kinnitamise kuupäev.  

Näide  Õppekorralduseeskiri. Pärnu Saksa Tehnoloogiakool, 15.10.2015 

 

Konspektide kasutamisel allikmaterjalina näidata: Kooli nimi. Õppeaine/teema konspekt, õppeaasta. 

Näide Pärnu Saksa Tehnoloogiakool. Rakendusmatemaatika konspekt, 2013/2014 õa. 

 

Lisade vormistamine 

Lisadesse paigutatakse töö põhiosa mõistmiseks vajalikku täiendavat ja mahukat informatsiooni (näiteks 

programmi väljatrükk, aruandlus, joonised A4 formaadis ja suuremad vms) 

Lisad paigutatakse kasutatud kirjanduse loetelu järele uuele lehele.  

Lisad pealkirjastatakse ja nummerdatakse (kui lisasid on rohkem kui üks) vastavalt neile tekstis viitamise 

järjekorrale. 

Lisa ülemisse vasakusse nurka kirjutatakse teise pealkirjastiiliga (Heading 2) : Lisa 1. Pealkiri – lühendit 

„nr“ ja punkti pealkirja lõppu ei panda.  

Kõik lisad: 

• pealkirjastatakse;  

• nummerdatakse araabia numbritega; 

• algavad uuelt lehelt; 

• märgitakse töö sisukorda. 

Kui lisasid on palju, võib selguse mõttes esitata lisade loetelu eraldi enne lisasid ning sel juhul neid 

sisukorda eraldi märkima ei pea. 

Näide 

http://www.eki.ee/dict/qs/


 

 

Lisad 

Lisa 1. Tiitellehe näidis 
 

 

PÄRNU SAKSA TEHNOLOOGIAKOOL 

eriala 
 

 

 

 

 

 

 

 

 

 

 

Õpilase ees- ja perenimi 
 

PRAKTIKAARUANNE 
 

 

 

 

 

 

 

 

Juhendaja: 

Ees- ja perenimi 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Pärnu 2023 
  



 

 

Lisa 2. Sisukorra näidis 
 

Sisukord 

 

 

 


